Planning and Development of Wind Farms: Wind Resource Assessment and Siting

Niels G. Mortensen
DTU Wind Energy Report-I-45
January 2013
Summary (max. 2000 characters):
These course notes are intended for the three-week course 46200 Planning and Development of Wind Farms given at the Technical University of Denmark. The purpose of the course notes is to give an introduction to wind resource assessment and siting issues using the WAsP suite of programs.

In no event will the Technical University of Denmark (DTU) or any person acting on behalf of DTU be liable for any damage, including any lost profits, lost savings, or other incidental or consequential damages arising out of the use or inability to use the information presented in this report, even if DTU has been advised of the possibility of such damage, or for any claim by any other party.
Contents

1 Introduction 5
  1.1 Observation-based wind resource assessment 6
  1.2 Numerical wind atlas methodologies 7

2 Meteorological measurements 8
  2.1 Design of a measurement programme 8
  2.2 Quality assurance 8

3 Wind-climatological inputs 9
  3.1 Wind data analysis 9
  3.2 Observed wind climate 10

4 Topographical inputs 11
  4.1 Elevation map 11
  4.2 Land cover map 12
  4.3 Sheltering obstacles 14

5 Wind farm inputs 14
  5.1 Wind farm layout 14
  5.2 Wind turbine generator 15

6 WAsP modelling 15
  6.1 Modelling parameters 15
  6.2 WAsP analysis 17
  6.3 WAsP application 18
  6.4 Verification of the modelling 18
  6.5 Special considerations 21

7 Modelling error and uncertainty 23
  7.1 Prediction biases 25
  7.2 Sensitivity analysis 25
  7.3 Uncertainty estimation 25

8 Additional losses 27

9 Wind conditions and site assessment 27
  9.1 Extreme wind and turbulence intensity 29
  9.2 Wind conditions and site assessment 30

References 30

Acknowledgements 32

Appendices 32

WAsP best practice and checklist 33
A note on the use of SAGA GIS 35
Digitisation of the land cover / roughness map 39
46200 Planning and Development of Wind Farms

The general course objectives, learning objectives and contents for DTU 46200 are listed below for reference. The full course description is given in the DTU Course Catalogue. The present notes are related to the wind resource assessment and siting parts only.

General course objectives

The student is provided with an overview of the steps in planning and managing the development of a new wind farm. The student is introduced to wind resource assessment and siting, wind farm economics and support mechanisms for wind energy. An overview of the various environmental impacts from wind farms is offered.

Learning objectives

A student who has met the objectives of the course will be able to:

- Describe the methodologies of wind resource assessment and their advantages and limitations.
- Explain the steps in the selection of a site for measurement of the wind resource and good practice for measurement of the wind resource.
- Calculate the annual energy production using the WAsP software for simple wind farm cases in terrain within the operational envelope of the WAsP model.
- Identify and describe factors adding to the uncertainty of the wind resource and wind farm production estimates.
- Estimate the most important key financial numbers of a wind project and explain their relevance.
- Identify the main environmental impact from a wind farm and suggest mitigation measures.
- List the three most common policy tools for support of wind energy projects.
- Explain the steps in the development of a wind farm layout considering annual energy production, wind turbine loads and environmental impact.
- Explain the main steps in developing the grid connection of a wind farm.

Contents

An introduction to market, policy and support mechanisms relevant to wind energy. Wind resources and wind conditions: anemometry; design and siting of meteorological stations; wind distributions; observed, generalized and predicted wind climates; observational and numerical wind atlases, climatological variability, elevation maps and morphometric analyses; land cover, roughness classes and roughness maps; sheltering obstacles; wind farm wake effects, micro-scale flow modelling (WAsP), wind resource mapping; wind farm layout; wind farm annual energy production. The procedure for obtaining an environmental permit of a wind farm. The various types of environmental impact from a wind farm. Introduction to wind farm economics. Introduction to grid connection. The students will work in groups of 3 or 4. The group work will be documented in a report and will be presented orally for all course participants.
1 Introduction

Wind resource assessment is the process of estimating the wind resource or wind power potential at one or several sites or over an area. One common result of the assessment could be a wind resource map, see Figure 1.

![Wind resource map for Serra Santa Luzia region in Northern Portugal.](image1)

Figure 1. Wind resource map for Serra Santa Luzia region in Northern Portugal.

The wind resource map usually shows the variation over an area of the mean wind speed or power density for a given height above ground level. While this may provide an indication of the magnitude of the wind resource, a more realistic estimate is obtained when the sector-wise wind speed distributions are combined with the power curve of a given wind turbine to obtain a power production map, see Figure 2.

![Wind resource map for a sample wind farm in Northern Portugal.](image2)

Figure 2. Wind resource map for a sample wind farm in Northern Portugal.
The result of wind resource assessment is therefore an estimate of the mean wind climate at one or a number of sites, in the form of the:

- Wind direction probability distribution (wind rose), which shows the frequency distribution of wind directions at the site, i.e. where the wind comes from,
- Sector-wise wind speed probability distributions, which show the frequency distribution of wind speeds at the site.

Wind resource assessment provides one important input for the siting, sizing and detailed design of the wind farm and these inputs are exactly what the WAsP software provides.

When it comes to the siting of individual wind turbines, a site assessment (IEC 61400-1) is usually carried out. This will provide estimates for each wind turbine site of the 50-year extreme wind, shear of vertical wind profile, flow and terrain inclination angles, free-stream turbulence, wind speed probability distribution and added wake turbulence. This additional information may be obtained by using the WAsP Engineering software.

1.1 Observation-based wind resource assessment

Conventionally, wind resource assessment and wind farm calculations are based on wind data measured at or nearby the wind farm site. The WAsP software is an implementation of the so-called wind atlas methodology (Troen and Petersen, 1989); this is shown schematically in Figure 3.

**Figure 3. The wind atlas methodology of WAsP.** Meteorological models are used to calculate the generalised wind climatology from the measured data – the analysis part. In the reverse process – the application of wind atlas data – the wind climate at any specific site may be calculated from the generalised wind climatology.

Note that the WAsP software estimates the potential power production only (steps 1-7 in Figure 3); the post-processing steps (8-9) must be carried out separately.
As can be deduced from Figure 3, WAsP is then based on two fundamental assumptions: first, the generalised wind climate is assumed to be nearly the same at the predictor (met. station) and predicted sites (wind turbines) and, secondly, the past (historic wind data) are assumed to be representative of the future (the 20-y life time of the wind turbines). The reliability of a given WAsP prediction depends very much on the extent to which these two assumptions are fulfilled.

1.2 Numerical wind atlas methodologies

WAsP has become part of a much larger framework of wind atlas methodologies, which also encompasses mesoscale modelling and satellite imagery analysis. This framework has been developed over the last decades at Risø and DTU (Frank et al., 2001; Badger et al., 2006; Hansen et al., 2007) in order to be able to assess the wind resources of diverse geographical regions where abundant high-quality, long-term measurement data does not exist and where important flow features may be due to regional-scale topography. Figure 4 is a schematic presentation of the entire framework.

<table>
<thead>
<tr>
<th>Mesoscale</th>
<th>Pre-processing</th>
<th>Modelling</th>
<th>Post-processing</th>
<th>Numerical WA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind classes</td>
<td></td>
<td>Metoscale model; e.g. KAMM, WRF, MC2, MMS or similar.</td>
<td>Predicted wind climate</td>
<td>Metoscale maps</td>
</tr>
<tr>
<td>Terrain elevation</td>
<td></td>
<td></td>
<td>Regional wind climate</td>
<td>Database of results</td>
</tr>
<tr>
<td>Terrain roughness</td>
<td></td>
<td></td>
<td>Predicted wind resource</td>
<td>WAsP *.LIB files</td>
</tr>
<tr>
<td>Input specifications</td>
<td></td>
<td></td>
<td></td>
<td>Uncertainties</td>
</tr>
<tr>
<td>Model setup</td>
<td></td>
<td></td>
<td></td>
<td>Parameters</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Measurements</th>
<th>Met. stations</th>
<th>Wind data</th>
<th>Verification</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siting</td>
<td></td>
<td>Data collection</td>
<td>Meso- and microscale results vs. measured data</td>
<td>Best practices</td>
</tr>
<tr>
<td>Design</td>
<td></td>
<td>Quality control</td>
<td>Adjust model and model parameters to fit data</td>
<td>Courses and training</td>
</tr>
<tr>
<td>Construction</td>
<td></td>
<td>Wind database</td>
<td>Satellite imagery (offshore sites only)</td>
<td>Microscale flow model</td>
</tr>
<tr>
<td>Installation</td>
<td></td>
<td>Wind statistics</td>
<td></td>
<td>Wind farm wake model</td>
</tr>
<tr>
<td>Operation</td>
<td></td>
<td>Observed wind climate</td>
<td></td>
<td>Wind farm AEP</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Microscale</th>
<th>Pre-processing</th>
<th>Modelling</th>
<th>Post-processing</th>
<th>Observational WA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wind speed distributions</td>
<td></td>
<td>Microscale model: Linearised, e.g. WAsP, MS-Micro or similar.</td>
<td>Regional wind climate</td>
<td>Microscale maps</td>
</tr>
<tr>
<td>Wind direction distribution</td>
<td></td>
<td>Non-linear, e.g. CFD (Computational Fluid Dynamics)</td>
<td>Predicted wind climate</td>
<td>Database of results</td>
</tr>
<tr>
<td>Terrain elevation</td>
<td></td>
<td></td>
<td>Predicted wind resource</td>
<td>WAsP *.LIB files</td>
</tr>
<tr>
<td>Terrain roughness</td>
<td></td>
<td></td>
<td></td>
<td>Uncertainties</td>
</tr>
<tr>
<td>Sheltering obstacles</td>
<td></td>
<td></td>
<td></td>
<td>Parameters</td>
</tr>
</tbody>
</table>

Figure 4. Overview of state-of-the-art wind atlas methodologies (Hansen et al., 2007).

Wind resource assessment based on mesoscale modelling, a numerical wind atlas, can provide reliable data for physical planning on national, regional or local scales, as well as data for wind farm siting, project development, wind farm layout design and micro-siting of wind turbines. Bankable estimates of the power production from prospective wind farms require additional on-site wind measurements for one or several years.

The present course notes thus describe mainly the ‘grey’, ‘green’ and ‘yellow’ parts of the diagram above, i.e. what is referred to as the observational wind atlas methodology. Different inputs to the WAsP modelling are described in Sections 2 to 5; the modelling itself is described in Section 6, and the modelling errors and uncertainties in Section 7. Section 8 lists the different types of additional losses in the wind farm and Section 9 contains a very brief cookbook approach to site assessment using WAsP Engineering.

In addition to these notes, the WAsP help system contains a Quick Start Tutorial section which illustrates the essentials of the WAsP software user interface.
2 Meteorological measurements

WAsP predictions are based on the observed wind climate at the met. station site; i.e. time-series data of measured wind speeds and directions over one or several years that have been binned into intervals of wind direction (the wind rose) and wind speed (the histograms). Therefore, the quality of the measurement data has direct implications for the quality of the WAsP predictions of wind climate and annual energy production. In short, the wind data must be accurate, representative and reliable.

2.1 Design of a measurement programme

It is beyond the scope of this report to describe best practice of wind measurements in detail, but the following aspects are particularly important. If possible, the measurement programme should be designed based on a preliminary WAsP analysis of the wind farm site. Such design ensures that the measurements will be representative of the site, i.e. that the mast site(s) cover the relevant ranges of elevation, land cover, exposure, ruggedness index, etc. found on the site. In short, we apply the WAsP similarity principle (Landberg et al., 2003) as much as possible when siting the mast(s). This design analysis may conveniently be based on SRTM elevation data and land cover information from satellite imagery such as Google Earth.

It is equally important in the design stage to use an observed wind climate that resembles the wind climate that may be observed at the wind farm site; e.g. by using data from a nearby met. station or modelled data from the region. A representative wind rose is particularly valuable as it may be used to determine the design of the mast layout; e.g. the optimum boom direction is at an angle of 90° (lattice mast) or 45° (tubular mast) to the prevailing wind direction. The height of the top (reference) anemometer(s) should be similar to that of the wind turbine hub height; preferably $> 2/3 h_{hub}$.

Anemometers should be individually calibrated according to international or at least traceable standards. Several levels of anemometry should be installed in order to obtain a high data recovery rate (above 90-95%) and for analyses of the vertical wind profiles. Air temperature (preferably at hub height) and barometric pressure should be measured in order to be able to calculate air density, which is used to select the appropriate wind turbine power curve data.

It is extremely valuable – and sometimes required for bankable estimates – to install two or more masts at the wind farm site; cross-prediction between such masts will provide assessments of the accuracy and uncertainty of the flow modelling over the site. Two or more masts are also required in complex terrain, where ruggedness index (RIX) and ΔRIX analyses are necessary.

2.2 Quality assurance

For projects where the measurement campaign has already been initiated or carried out, it is important to try to ensure the quality of the collected wind data, as well as to ensure the quality of any and all site data used for the analysis. A site inspection trip is required and should be part of any (commercial) WAsP study – whether it is a second opinion, due diligence or feasibility study.

A number of WAsP Site/Station Inspection checklists and forms exist for planning the site visit and for recording the necessary information. The positions of the met. mast(s)
and turbine sites are particularly important. Bring a handheld GPS (Global Positioning System) for the site visit and note down the projection and datum settings; change these if required. Determine the coordinates of all masts, turbine sites, landmarks and other characteristic points on site.

Documentation of the mast setup and site may be done by taking photos of the station and its surroundings (12 × 30°-sector panorama). Use a compass when taking the sector pictures. Download the GPS data and photographs to your PC as soon as possible (daily).

The characteristics of anemometers and wind vanes deteriorate over time and after one or a few years they may not operate according to specifications. An important part of operating a wind-monitoring mast is therefore to exchange the instruments at regular intervals, as well as rehabilitating and recalibrating instruments in stock.

3 Wind-climatological inputs

The wind-climatological input to WAsP is given in the observed wind climate, which contains the wind direction distribution (wind rose) and the sector-wise distributions of mean wind speed (histograms), see Figure 5. The observed wind climate file should also contain the wind speed sensor (anemometer) height above ground level in metres and the geographical coordinates of the mast site: latitude and longitude. The latitude is used by WAsP to calculate the Coriolis parameter.

![Figure 5. Sample observed wind climate from Sprogø 1977-99; wind rose to the left and omni-directional wind speed distribution to the right (data courtesy of Sund & Bælt).](image)

Wind speeds must be given in metres per second [ms⁻¹] and wind directions in degrees clockwise from north [°], i.e. from 0° (north) through 360°. The wind direction indicates the direction from which the wind blows. The observed wind climate is usually given for 12 sectors and the wind speed histograms using 1 ms⁻¹ wind speed bins.

3.1 Wind data analysis

The wind data analysis and calculation of the observed wind climate may conveniently be done using the WAsP Climate Analyst. Whether the wind data are measured by the organisation carrying out the analysis or by a third party, a number of data characteristics must be known, such as: the data file structure, time stamp definition, data resolution (discretisation), calm thresholds, and any flag values used for calms and missing data. This information may be collected by filling out a WAsP Data Description Form; in the subsequent analysis all input values in the Climate Analyst protocol (import filter) editor should correspond to the data specifications.
In the Climate Analyst, the time traces of wind direction and speed, as well as a polar representation of concurrent data, can be plotted and inspected, see Figure 6.

Figure 6. Time traces of wind direction (upper, 0-360°) and wind speed (lower, 0-30 m/s) from Sprogø for the year 1979. The graphic in the lower left of the Climate Analyst window shows concurrent data in a polar representation (data courtesy of Sund & Bælt).

The Climate Analyst checks the time stamps and observation intervals upon input of each data file, and also checks for missing records in the data series. However, the main quality assurance (QA) is done by visual inspection of the time series and polar plot, as well as the resulting observed wind climate. Things to look out for are e.g.:

1. Are there any spikes or sudden drops in the data series?
2. Are there periods of constant data values in the data series?
3. Are there periods of missing data in the data series?
4. Are there any unusual patterns in the data series?
5. Are there any unusual patterns in the polar scatter plot?
6. Do the wind speed time traces follow each other for different anemometers?
7. Do the wind direction time traces follow each other for different vanes?
8. Do the measured and Weibull-derived values of \( U \) and \( P \) compare well?
9. Does the calm class (0-1 ms\(^{-1}\)) in the histogram look realistic?

Finally, the observed wind climate is calculated and exported to an OWC file. The OWC file can subsequently be inserted into the WAsP hierarchy, as a child of a meteorological station member.

3.2 Observed wind climate

The observed wind climate (OWC) should represent as closely as possible the long-term wind climate at anemometer height at the position of the meteorological mast. Therefore, an integer number of full years must be used when calculating the OWC, in order to avoid any seasonal bias. For the same reason, the data recovery rate must be quite high (> 90-95%) and any missing observations should preferably be distributed randomly over the entire period.

Wind data series from prospective wind farm sites rarely cover more than one or a few full years, so they must be evaluated within context of the long-term wind climate, in order to avoid any long-term or climatological bias. Comparisons to near-by, long-term
meteorological stations or to long-term modelled data for the area can be made using simple (or complicated) measure-correlate-predict (MCP) techniques.

WAsP uses Weibull distributions to represent the sector-wise wind speed distributions and the emergent distribution for the total (omni-directional) distribution. The difference between the fitted (and emergent) and the observed wind speed distributions should therefore be small: less than about 1% for mean power density (which is used for the Weibull fitting) and less than a few per cent for mean wind speed.

4 Topographical inputs

The topographical inputs to WAsP are given in the vector map, which can contain height contour lines, roughness change lines and lines with no attributes (say the border of the wind farm site). In addition, nearby sheltering obstacles may be specified in a separate obstacle group member and shown on the map.

Map coordinates and elevations must be specified in meters and given in a Cartesian map coordinate system. The map projection and datum should be specified in the Map Editor so this information is embedded in the map file. All metric coordinates used in the WAsP workspace should of course refer to the same map coordinate system. Obstacle distances and dimensions must likewise be given in meters.

The Map Editor can do the transformation from one map coordinate system to another; the Geo-projection utility program in the Tools menu can transform single points, lists of points and lists of points given in an ASCII data file.

4.1 Elevation map

The elevation map contains the height contours of the terrain. These may be digitised directly from a scanned paper map – as described in the Map Editor Help facility – or may be obtained from a database of previously digitised height contours, established by e.g. the Survey and Cadastre of a country or region. Alternatively, they can also be generated from gridded or random spot height data using contouring software.

The elevation map should extend at least several (2-3) times the horizontal scale of significant orographic features from any site – met. mast, reference site, turbine site or resource grid point. This is typically 5-10 km. A widely cited rule for the minimum extent of the map is \( \max(100 \times h, 10 \text{ km}) \); this is usually sufficient for the elevation map.

The accuracy and detail of the elevation map are most critical close to the site(s), therefore it is recommended to add spot heights within the wind farm site and close to the met. mast(s); one may also interpolate extra contours if necessary. The contour interval should be small (\( \leq 10 \text{ m} \)) close to calculation sites, whereas the contour interval can be larger further away from the calculation sites (\( \geq 10 \text{ m} \)).

Non-rectangular maps (circular, elliptic, irregular) are allowed and sometimes preferred in order to reduce the number of points in the map, while at the same time retaining model calculation accuracy.

The final elevation map should be checked for outliers and errors by checking the range of elevations in the map. An elevation map generated from a gridded data set could also be compared to a scanned paper map of the same area.
Contour maps from gridded data

High-resolution gridded (or raster) elevation data exist for many parts of the world, one such data set is the Shuttle Radar Topography Mission (SRTM). The current version of WAsP cannot employ such data directly, so it is necessary to make a height contour (vector) map from the raster data. One freely available software program that can be used to make WAsP vector maps from SRTM data is described in the appendix “A note on the use of SAGA GIS”.

4.2 Land cover map

The land cover (roughness length) map contains a classification of the land cover, where each class/area is characterised by a specific roughness length value, \( z_0 \). The roughness change lines may be digitised from a scanned paper map, aerial photograph or satellite imagery as described in the Map Editor Help facility. They may also be obtained from a database of previously digitised land cover, established by e.g. the Survey and Cadastre of a country or region. The Corine database covering the EU countries is an example of one such database, see Figure 8.

Internal boundary layer theory suggests that the roughness map should extend to at least 100\( \times h \) from any site – meteorological mast, reference site, turbine site or resource grid point – where \( h \) is the height of the WAsP calculation. However, it turns out that this is not enough, and at least 50\% are often added to this number. For a wind turbine with a hub height of 80 m, the roughness map will therefore be about 25\( \times 25 \) km\(^2\). For a wind farm of 80-m turbines, the extent of the wind farm area should be added to this size.
Roughness lengths must be specified in meters and the roughness length of water surfaces must be set to 0.0 m! This is because WAsP uses this value as a flag value: ‘0 m’ indicates a water surface, whereas a small roughness length means a smooth land surface (snow, sand, bare soil and the like).

The final roughness map should be checked systematically for errors, since these may give rise to unpredictable results in the WAsP calculations. Check the range of roughness length values in the main window of the Map Editor, and check for dead ends and cross points in the map display window (View > Nodes, Dead ends and Cross points). Some map editing will be needed to eliminate any dead ends and cross points.

When there are no more dead ends and cross points in the map, the consistency of the roughness values must be checked (View > Line Face Roughness errors) – there must be no line face roughness (LFR) errors! Finally, the roughness classification and values should be validated against a scanned paper map or by viewing the roughness change lines in Google Earth. The map may also be verified during a visit to the site.

All maps and images of the terrain are snapshot of the state of the terrain surface. The land cover and roughness length information used should of course correspond to the modelling scenario: use a historic or present-day map for modelling the meteorological mast(s) and use a present-day (or future) map for modelling the wind farm.

**Roughness maps from gridded data**

High-resolution gridded (or raster) land cover data exist for many parts of the world. The current version of WAsP cannot employ such data directly, so it is necessary to construct a vector map from the raster data. There is currently no standard procedure for making vector roughness maps from raster land cover data; however, some techniques have been demonstrated using GIS systems.
4.3 Sheltering obstacles

Terrain features such as houses, walls, shelter belts, or a group of trees, that are quite close to the WASP calculation site may be treated as sheltering obstacles and modelled using the shelter model of WASP, see Figure 3. The following simple rule of thumb may be used to determine which model to use:

- If the site (anemometer, turbine hub or other calculation point) is closer to an obstacle than about 50 obstacle heights ($H$) and its height lower than about 3 obstacle heights – then treat it as a sheltering obstacle and use the shelter model.
- If the site is further away then $50H$ and/or higher than $3H$, then treat the feature as a roughness element, i.e. adding to the general roughness of the terrain.

5 Wind farm inputs

The wind farm inputs to WASP consist of the layout of the wind farm (turbine site coordinates) and the characteristics of the wind turbine generator(s): hub height, rotor diameter and the site-specific power and thrust curve(s).

5.1 Wind farm layout

WASP does not contain any layout design tools, so the layout must be done free-hand or calculated in e.g. MS Excel. Turbine site coordinates may then be copied and pasted into WASP. Free-hand layouts may be established quickly in the vector map by pressing the Ctrl-key and then dragging a turbine site (cloning) to a new turbine position. Distance circles around the turbine positions can be shown in the Spatial view as an aid in keeping a certain distance between the turbine positions.

Figure 9. Sample wind farm layout in Zafarana, Egypt. The layout is mainly determined by the available land, the wind resource and aesthetics. Row 1-3 follow simple arcs, in which the positions were calculated using MS Excel; row 4 follow a terrain feature and the positions were originally drafted by hand.
5.2 Wind turbine generator

It is important to use site-specific wind turbine generator data (i.e. power and thrust coefficient curves) when calculating the AEP of the wind farm. These may be chosen by selecting the right performance table in the wind turbine generator window in WAsP; where the tables correspond to specific values of air density and/or noise level. If such data do not exist already, they have to be obtained from the wind turbine manufacturer.

![Figure 10. Power and thrust curves for a Vestas V90 3-MW wind turbine. Different tables (lower left) may correspond to different air densities or sound levels.](image)

6 WAsP modelling

Most WAsP studies in the past have been carried out using the default parameters of WAsP. With version 10, project air density was added as a parameter and this is now regularly changed as described below. The wind atlas structure is also often changed because of the many masts and turbines with heights between 50 and 100 meters. Finally, more users have begun tweaking the heat flux values in order to better model the vertical wind profile.

6.1 Modelling parameters

A few modelling parameters may be changed at an early stage in the WAsP calculations: site air density, wind atlas heights and wind atlas roughness classes.

**Site air density**

An estimate of the site air density must be made at any wind turbine or wind farm site in order to calculate a realistic wind power density and annual energy production (AEP). Air density can be calculated from measurements of atmospheric pressure and ambient air temperature at the site:

\[
\rho = \frac{B \times 100}{R \times (T + 273.15)}
\]

(1)

where \( \rho \) is air density (kg m\(^{-3}\)), \( B \) is atmospheric pressure (hPa), \( R \) is the gas constant for dry air (287.05 J kg\(^{-1}\) K\(^{-1}\)) and \( T \) is air temperature (°C).
If measurements of atmospheric pressure are not carried out, the *Air Density Calculator* of WAsP can be used to estimate the air density from site elevation and the annual average air temperature at the site. A comparison of measured and WAsP-derived mean air densities for 10 sites in South Africa and eight sites in NE China (Mortensen *et al.*, 2010) is shown in Figure 11.

![Figure 11. Measured and estimated mean air densities for 10 stations in South Africa and eight stations in NE China (Mortensen *et al.*, 2010).](image)

The appropriate performance table in the *Wind turbine generator* member of WAsP is selected using the calculated or estimated site air density.

**Wind atlas structure**

The generalised wind climate, represented by the *wind atlas* member in WAsP, is specified for five standard heights above ground level and five land cover (roughness) classes. These standard conditions should span the characteristics of all calculation sites in the project and WAsP is then able to interpolate between these conditions. However, they may also be adapted to the project in question.

The default heights in the WAsP wind atlas are 10, 25, 50, 100 and 200 m a.g.l. If the wind turbine hub heights or anemometer heights are somewhere between these values, one or more of these heights may be adapted to the project characteristics; e.g. 10, 20, 60, 90 and 120 m, see Figure 12. A maximum of five heights can be specified.

The default roughness classes in the wind atlas correspond to roughness lengths ($z_0$) of 0, 0.03, 0.10, 0.40 and 1.5 m. If large parts of the terrain has a roughness length somewhere between these values, e.g. like the low values for many desert surfaces, one or more of these values may be adapted to the project.
Atmospheric stability

WAsP contains a stability model which employs separate mean and RMS heat flux values for over-land and over-water conditions; where over-water conditions are defined as areas of the vector map where the roughness length $z_0 = 0$ m. The default wind profile over land corresponds to slightly stable conditions and the wind profile over water to near-neutral conditions; the exact heat flux values are given in the WAsP project configuration.

The default heat flux values were originally determined for the European Wind Atlas (Troen and Petersen, 1989) but have also worked well for many other parts of the world. Note, that the heat fluxes are not identical to what can be measured using e.g. a sonic anemometer, but have the same qualitative meaning.

The mean (and rarely RMS) heat flux value may be adjusted to site conditions – in order to tweak the wind profile slightly – but this should only be done following careful analysis and improvement of the elevation and land cover map. Furthermore, mast flow distortion should be evaluated and taken into account in the analysis. Since the heat flux values cannot be determined objectively, they must be based on careful wind profile analysis, see Figure 16.

6.2 WAsP analysis

WAsP analysis is the transformation of the wind climate observed at a met. station to the generalised (also called regional) wind climate, the wind atlas member in WAsP. A typical WAsP analysis as it appears the WAsP hierarchy is shown in Figure 13.

The wind atlas may be dynamic, as shown in Figure 13 with an open book, or static, if the wind atlas data set is simply a previously calculated data file. The dynamic wind atlas may contain a map, which is then specific to the met. station site. The met. station can contain an obstacle group, which is then specific to the met. mast. The map and obstacle group should of course correspond to the conditions in the time period when the wind measurements were taken.
The observed wind climate is always child of a met. station, which is always child of a wind atlas (generalised wind climate).

### 6.3 WAsP application

WAsP application is the transformation of the generalised wind climate (wind atlas) to the predicted wind climate at one or more sites, such as those of the turbine site, wind farm, reference site or resource grid members of the WAsP hierarchy. A typical WAsP application as it appears the WAsP hierarchy is shown in Figure 14.

![WAsP hierarchy diagram](image)

**Figure 14.** The wind atlas, vector map and wind turbine generator are inputs to the application; the turbine site, wind farm and resource grid contain the prediction outputs.

While this setup is the most common, it is also possible for the wind atlas member to be a child of any of the calculating members shown in Figure 14, including a turbine site group. In this way, more masts than one may be used for the predictions.

**Wind farm**

A wind farm consists of a number of wind turbines, which may be arranged in **turbine site groups**. The wake model is invoked automatically for the wind turbines in a wind farm; however, two or more 1st level wind farms in the WAsP hierarchy do not interact. So, all the wind turbines that should be part of a given wake calculation must be in the same (1st level) wind farm.

**Reference site**

The reference site member is used to relate wind farm power production to the wind speed and direction measured at a nearby mast, i.e. to establish a **wind farm power curve**.

**Wind resource grid**

The wind resource grid corresponds to a regular grid of wind turbines, but no wake calculations are done. The results for each site corresponds to the free-stream or gross values. Remember, that the map requirements mentioned above should be fulfilled for all the sites in a resource grid.

### 6.4 Verification of the modelling

In general, predictions are based on data from only one set of instruments – anemometer and wind vane – on one mast. While this is sufficient to perform the calculations and get
some results, additional instruments on the same mast – and /or on another nearby mast – add significant value to a wind farm project.

### The vertical wind profile

If wind speed has been measured at two or more heights along the mast, it is possible (to some extent) to check if WAsP is able to model the vertical wind profile at the site. This comparison may be used to adjust the terrain descriptions and also (sometimes) the atmospheric stability settings. The top anemometer is almost always used as the reference level. The procedure is then:

1. Use the OWC from the reference anemometer to calculate the wind atlas.
2. Insert a Turbine site in the map at the location of the meteorological mast.
3. Set the calculation height to the height of the reference anemometer.
4. Update all calculations (right-click menu or press the F9 function key).
5. Highlight the Turbine site and go to Tools > Utility scripts menu.
6. Invoke the “Turbine site vertical profile (Excel)” script.

MS Excel will now start and show WAsP predictions for several levels between 5 and 100 m a.g.l. at the site of the mast:

- **Vertical wind profile report for sample mast**

<table>
<thead>
<tr>
<th>Height a.g.l. [m]</th>
<th>Wind speed [m/s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>3.43933</td>
</tr>
<tr>
<td>10</td>
<td>3.17942</td>
</tr>
<tr>
<td>15</td>
<td>3.02089</td>
</tr>
<tr>
<td>20</td>
<td>2.87475</td>
</tr>
<tr>
<td>25</td>
<td>2.72963</td>
</tr>
<tr>
<td>30</td>
<td>2.59358</td>
</tr>
<tr>
<td>35</td>
<td>2.46739</td>
</tr>
<tr>
<td>40</td>
<td>2.34973</td>
</tr>
<tr>
<td>45</td>
<td>2.23933</td>
</tr>
<tr>
<td>50</td>
<td>2.13636</td>
</tr>
<tr>
<td>55</td>
<td>2.04089</td>
</tr>
<tr>
<td>60</td>
<td>1.95233</td>
</tr>
<tr>
<td>65</td>
<td>1.86727</td>
</tr>
<tr>
<td>70</td>
<td>1.78681</td>
</tr>
<tr>
<td>75</td>
<td>1.70533</td>
</tr>
<tr>
<td>80</td>
<td>1.62089</td>
</tr>
<tr>
<td>85</td>
<td>1.53636</td>
</tr>
<tr>
<td>90</td>
<td>1.45523</td>
</tr>
<tr>
<td>95</td>
<td>1.37079</td>
</tr>
<tr>
<td>100</td>
<td>1.29000</td>
</tr>
</tbody>
</table>

WAsP predictions for several levels between 5 and 100 m a.g.l. at the site of the mast.

**Figure 15.** Results of running the “Turbine site vertical profile (Excel)” script in WAsP are shown in MS Excel. The “All” column is the omni-directional wind profile; sector-wise wind profiles (here, 1-12) are also calculated.

Column A contains the height above ground level, column B the total (omni-directional) mean wind speed predicted by WAsP for the different heights. Columns C to N show the sector-wise wind speed profiles. The vertical profile of power density is given below the wind speed profile.

Plot columns A and B to obtain the wind speed profile graph; then plot the measured mean wind speeds from any other level at the mast with symbols, in order to compare the WAsP-predicted profile to the measurements, see Figure 16 below. Measurements at all levels should of course refer to the same period of time.
Figure 16. Measured and modelled vertical wind profiles at two sites in South Africa (data courtesy of the WASA project). The blue profile was modelled using the default setup of WAsP 10.1; the green profile is a strictly neutral (logarithmic) wind profile, and the red profile has been adapted to the local conditions by changing the heat flux values in WAsP slightly.

The wind speed profile graph may now be adjusted by adjusting the terrain descriptions, i.e. the roughness length map and the elevation map. If these are thought to be reliable, the wind profile can further be tweaked a bit by changing the heat flux values in the project’s Configuration Editor. In Figure 16, the measured wind profile at mast WM05 is modelled well using the default heat flux values; whereas the measured wind profile at mast WM08 is much closer to neutral conditions. Here the mean heat flux was changed from $-40$ to $-10$ Wm$^{-2}$ in order to get a good model description of the profile.

Note that the wind speed measurements will rarely fit exactly to the wind speed profile, partly because the lower levels will always be influenced by flow distortion from the mast itself. In order to avoid this, one could model the wind speed profile in certain sectors only, where flow distortion is expected to be small. However, in this case there is a risk that these data are not representative of the average, annual site conditions.

**Cross predictions between masts**

If wind speed and direction have been measured at two or more masts within the wind farm site (or the region in which the regional wind climate is assumed to be similar), it may be possible to verify to what degree WAsP is able to model the wind speed variations across the wind farm site. This information may be used to adjust the terrain descriptions and (sometimes) the atmospheric stability settings in order to improve the WAsP modelling of the wind farm site.

The top anemometers are almost always used as reference levels. The procedure is then:

1. Make a WAsP project for each meteorological mast.
2. Insert all masts as Turbine sites in the projects.
3. Use each mast to predict the wind climates at the other masts.
4. Make a table with the results of the cross prediction, e.g.:
Here, the reference sites (predictor sites) are given above each column and the predicted sites in each row. The right-most column contains the measured mean wind speeds. The ‘self-predictions’ are given in the diagonal; these should be close to the measured values. All of the observed wind climates should of course refer to the same period of time.

The cross predictions may be improved by adjusting the terrain descriptions, i.e. the roughness length map and the elevation map. If these are thought to be reliable, the cross prediction results may further be tweaked a bit by changing the heat flux values in the project’s Configuration Editor. In complex (steep) terrain – as in the example above – the cross predictions may be influenced by the ruggedness of the terrain. In such cases, a ruggedness index (RIX) analysis should be carried out and one might try to find the relation between prediction error and ΔRIX.

### 6.5 Special considerations

This section covers three special types of terrain, where some adjustment of the WAsP modelling is necessary or which violate the operational envelope of the WAsP models.

#### Offshore

Off-shore and near-shore conditions are within the operational envelope of the WAsP models, but there are a few special issues to take into account. First of all, the wake decay constant $k$ should be changed to offshore conditions (in the Settings tab of the Wind farm window); a value of $k = 0.05$ is recommended. Secondly, the roughness length of the sea surface – like any other water surface in WAsP – should of course be set to 0.0 meters.

Because of the special foundations used for offshore meteorological masts and wind turbines, the height of the anemometer or wind turbine hub may be different from the nominal height of the mast or tower. In addition, many different vertical reference levels are used offshore. For WAsP modelling, the anemometer and wind turbine hub heights should be given in meters above mean sea level.

WAsP expects to encounter elevation or roughness change lines within 20 km from any site; for sites far offshore this may not happen and the model may throw an error. This can be remedied by changing the model interpolation radius in the project parameters or by adding a combined elevation/roughness change line around wind farm site itself.

There are no standard procedures for modelling of tidal flats or sea ice; in such cases it is recommended to study the effects through sensitivity analysis. The influence of air density and the heat flux values are treated in the same way as over land.
Referencing short-term measurements at an offshore site to the long-term climatology may be difficult because of the lack of nearby long-term stations. Here, different kinds of reanalysis or numerical wind atlas must be used.

**Forested terrain**

WAsP does not contain specific models or procedures for modelling the wind flow in, above and around forests. Forests are simply specified in the vector map by roughness change lines. This works well when the forest is far away from the sites.

If the meteorological mast or wind turbines are situated some distance within a forest, the effective modelling height (anemometer height or hub height) should be taken as the nominal height minus a *displacement length*. This displacement length – as well as the roughness length – is a function of the height of the trees and the stand density, but is often around 2/3 of the tree heights.

Close to the forest edge, the flow is quite complicated and WAsP cannot be expected to provide reliable results.

**Steep terrain**

WAsP was designed for gentle and not too steep terrain, in which the wind can follow the terrain surface, i.e. where the flow is *attached*. In steep terrain, where *flow separation* occurs, the flow modelling results will be biased. Flow separation occurs when the terrain slopes are larger than about 30% (17°) on a downwind slope to about 40% (22°) on an upwind slope (Wood, 1995).

WAsP evaluates the steepness of the terrain using the so-called *ruggedness index* RIX (Bowen and Mortensen, 1995), which is defined as the fraction of the terrain around a given site steeper than a critical slope (default value 30%). Complex or steep terrain is then when RIX > 0 for one or more sites. Analyses at wind farm sites suggest that the prediction error is proportional to the difference in ruggedness indices between the predicted site (wind turbine) and the predictor site (meteorological mast), see Figure 17.

![Figure 17](image.png)

*Figure 17. WAsP wind speed prediction error in per cent as a function of the difference in ruggedness indices, ΔRIX [%], between the predicted site and the predictor site. Data points represent cross-predictions between 5 masts in N Portugal. RIX values were calculated using the WAsP default set-up; other values may provide a better fit.*
Qualitatively, WAsP will overestimate the mean wind speed significantly if the terrain around the predicted site (turbine site) has a larger fraction of steep slopes than the predictor site (met. mast). And, conversely, WAsP will underestimate the mean wind speed if the predicted site has a smaller fraction of steep slopes. If the two sites are quite similar, the prediction errors seem to be small – even when both sites are characterised by large ruggedness indices.

The relation between prediction error and difference in ruggedness indices has been used to correct WAsP predictions in steep and complex terrain, where $|\Delta \text{RIX}|$ is larger than about 5% (Mortensen et al., 2006, 2008). Because of the empirical nature of the relation, this requires that the local slope of the fitted line in Figure 17 can be established; i.e. there must be two or more met. masts on the site. If $|\Delta \text{RIX}|$ is smaller than 5%, the correction scheme is rarely used.

### 7 Modelling error and uncertainty

The difference between a WAsP prediction and the correct value is the *modelling error*. In general, the correct value is not known exactly, even when predicting another cup anemometer or a wind turbine, where the wind speed or production data are known. This is because these numbers are also determined with some uncertainty. However, they may be close estimates of the correct value.

Therefore, the modelling *uncertainty* should be estimated. The uncertainty is an estimate of the likely limits to the modelling error, and it is composed of all the uncertainties related to the entire modelling procedure. The different uncertainty factors tend to be random in nature and are often not correlated.

In addition, the modelling results may be *biased*. The biases represent any systematic deviations of the modelling result from the correct value. The biases should also be estimated and possibly corrected for. Figure 18 illustrates the meaning of uncertainty and bias, where the ‘mean value’ could correspond to a WAsP prediction.

![Figure 18. Modelling uncertainty and bias. The ‘mean value’ might correspond to the WAsP prediction ($P_{50}$); the ‘true value’ is the correct value we are trying to predict. The standard deviation of the normal distribution shown is 10% and the bias shown is 20%.](image-url)
The normal distribution shown in Figure 18 can be plotted to show the exceedance probability as a function of the annual energy production, see Figure 19.

**Figure 19.** Exceedance probability curve corresponding to the normal distribution shown in Figure 18.

Also shown in Figure 19 are the $P_{90}$, $P_{75}$ and $P_{50}$ values, which correspond to exceedance probabilities of 90%, 75% and 50%, respectively. Different standard deviations of the normal distribution (different uncertainty estimates) will result in different exceedance curves. With a large standard deviation (uncertainty), the differences between the $P_{90}$, $P_{75}$ and $P_{50}$ values become large; with a small standard deviation the differences will be small, see Figure 20.

**Figure 20.** Exceedance probability curves corresponding to normal distributions with different standard deviations: 20, 15, 10, 5 and 3%, respectively. The steeper the central part of the curve, the smaller the standard deviation. The $P_{90}$ values are shown too.
7.1 Prediction biases

There are many examples of possible biases in a WAsP prediction, but they may be small and difficult to estimate and are often treated as simply adding to the uncertainty. As an example, mean wind speeds measured with a cup anemometer are inherently biased because of the behaviour of the instrument in a turbulent flow; however, these biases are often treated as part of the overall measurement uncertainty.

Large biases occur in complex (steep) terrain where $|\Delta RIX|$ is larger than about 5%. If WAsP is applied in such terrain, the local relation between prediction error and $\Delta RIX$ should be established and all predictions should be corrected accordingly.

7.2 Sensitivity analysis

Sensitivity analysis (SA) is the study of how the variation (uncertainty) in the output of a mathematical model can be apportioned, qualitatively or quantitatively, to different sources of variation in the input of the model (Wikipedia, 2010). In other words, it is the process of systematically changing the input data and parameters in the WAsP modelling in order to determine the effects of such changes on the output; which in this case is the estimated annual energy production (AEP) of a wind turbine or a wind farm. Sensitivity analysis thus investigates the robustness and uncertainty of the microscale modelling.

Table 1. Sensitivity analyses for sample 70-m mast on a hill in Northern China.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Input change</th>
<th>Change in predicted AEP @ h</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>75 m</td>
</tr>
<tr>
<td>$U$ calibration</td>
<td>+1%</td>
<td>1.5%</td>
</tr>
<tr>
<td>Anemometer height</td>
<td>-1%</td>
<td>0.3%</td>
</tr>
<tr>
<td>Adapted atlas heights</td>
<td>standard → h</td>
<td>0.9%</td>
</tr>
<tr>
<td>Direction offset</td>
<td>+10°</td>
<td>0.7%</td>
</tr>
<tr>
<td>Air density</td>
<td>-2.5%</td>
<td>-1.4%</td>
</tr>
<tr>
<td>Stability</td>
<td>→ neutral</td>
<td>-1.4%</td>
</tr>
<tr>
<td>Heat flux</td>
<td>+10 Wm$^{-2}$</td>
<td>0.2%</td>
</tr>
<tr>
<td>BG roughness</td>
<td>half of 5 cm</td>
<td>0.4%</td>
</tr>
<tr>
<td>BG roughness</td>
<td>double of 5 cm</td>
<td>0.0%</td>
</tr>
<tr>
<td>Position of mast</td>
<td>±10 m</td>
<td>0.2%</td>
</tr>
<tr>
<td>Elevation detail</td>
<td>SRTM 3 only</td>
<td>-0.2%</td>
</tr>
</tbody>
</table>

Table 1 shows results for a sample WAsP calculation in NE China: The changes in the predicted AEP at 75, 100 and 125 m a.g.l. when changing the inputs to the modelling. In this case, the uncertainty was minimised by using calibrated anemometers, adapting the wind atlas heights, adjusting the heat flux values, and adding details to the SRTM map.

7.3 Uncertainty estimation

The European Wind Energy Technology Platform (TPWind) recently proposed a ‘3% vision’, stating that “current techniques must be improved so that, given the geographic coordinates of any wind farm (flat terrain, complex terrain or offshore, in a region covered by extensive data sets or largely unknown) predictions with an uncertainty of less than 3% can be made concerning the annual energy production and other wind conditions”. This 3% vision is illustrated in Figure 21.
Figure 21. Sample AEP distributions: TPWind goal for 2030 (3% uncertainty), WAsP verification study of operating wind farms (5%) and numerical wind atlas study (9%).

Also shown in Figure 21 is the result of a WAsP verification study, where actual wind farm productions from 20 operating wind farms were compared to the original WAsP predictions. The numerical wind atlas (NWA) data are from the Wind Atlas for Egypt (Mortensen et al., 2005)

Unlike the technical losses described below, the sources of uncertainty have not been classified in a similar systematic way. The EWEA Comparison of Resource and Energy Yield Assessment Procedures (Mortensen et al., 2012) shows that a broad selection of significant players in the wind energy industry applies quite different classifications and evaluation practices. Some sources of uncertainty seem to be generally accepted, though the exact definition and calculation are not always clear. Commonly accepted sources of uncertainty are listed in Table 2. Typical ranges for the uncertainty factors are also given.

Table 2. Commonly used sources of uncertainty by category and type.

<table>
<thead>
<tr>
<th>Uncertainty category</th>
<th>Uncertainty type</th>
<th>Typical values</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Wind data</td>
<td>• wind measurements</td>
<td>2-5% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• long-term adjustment</td>
<td>1-3% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• inter-annual variability</td>
<td>2-6% on wind speed</td>
</tr>
<tr>
<td>2 Flow modelling</td>
<td>• vertical extrapolation</td>
<td>0-5% on wind speed</td>
</tr>
<tr>
<td></td>
<td>• horizontal extrapolation</td>
<td>0-5% on wind speed</td>
</tr>
<tr>
<td>3 Power conversion</td>
<td>• power curve</td>
<td>5-10% on AEP</td>
</tr>
<tr>
<td></td>
<td>• metering</td>
<td>0-2% on AEP</td>
</tr>
<tr>
<td>4 Losses</td>
<td>• wake effects</td>
<td>0-5% on AEP</td>
</tr>
<tr>
<td></td>
<td>• additional losses</td>
<td>0-2% on AEP</td>
</tr>
<tr>
<td>5 Other</td>
<td>• air density</td>
<td>0-2% on AEP</td>
</tr>
</tbody>
</table>

Every wind farm yield assessment report should contain an estimation of the uncertainty of the energy yield estimation. The total uncertainty on the energy yield prediction is usually calculated by applying the equation for an independent stochastic process to combine the main uncertainties. Only the main uncertainties are estimated and these are
assumed to be Gaussian distributed. With these assumptions, it is also possible to calculate the exceedance statistics, i.e. find yield levels with a certain probability of those levels being exceeded.

The aggregate uncertainty for the estimation of the yield of an onshore wind farm in Europe is often between 10 and 15% of AEP. An estimated uncertainty larger than 15% or lower than 10% should be highlighted and discussed.

8 Additional technical losses

The net AEP calculated by WASP is the ideal annual energy production that can be produced by the wind farm when wake losses only have been taken into account. This, however, is not the production that will be fed into the electrical grid at the point of common coupling (PCC). Several additional losses will occur between the wind turbine rotor(s) and the PCC; these losses are summarised in Table 3.

Table 3. Additional technical losses, which are not taken into account by WASP, may be grouped into the following five categories (European Wind Energy Association, 2009). Typical values for an onshore wind farm in NW Europe are listed too.

<table>
<thead>
<tr>
<th>Loss category</th>
<th>Technical loss type</th>
<th>Typical value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Availability • turbine availability</td>
<td>97%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• balance of plant availability</td>
<td>&gt; 99%</td>
</tr>
<tr>
<td></td>
<td>• grid availability</td>
<td>&gt; 99%</td>
</tr>
<tr>
<td>2 Electrical efficiency • operational electrical efficiency</td>
<td>1-2%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• wind farm consumption</td>
<td></td>
</tr>
<tr>
<td>3 Turbine performance • power curve adjustments</td>
<td>1-2%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• high-wind hysteresis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• control losses (SCADA)</td>
<td></td>
</tr>
<tr>
<td>4 Environmental • blade degradation and fouling</td>
<td>1-2%</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• icing or temperature shutdown</td>
<td></td>
</tr>
<tr>
<td>5 Curtailments • wind sector management</td>
<td>Design dependent</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• grid curtailment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• noise, visual and environmental</td>
<td></td>
</tr>
</tbody>
</table>

These losses must be estimated for each project in question and subtracted from the net AEP calculated by WASP, in order to obtain the metered production at the PCC. The additional losses vary greatly, but are often about 5-10% of the WASP net AEP in total. Evidently, it is paramount to know which production statistic is used for a WASP verification study. For wind farm economic analyses, the production fed into the grid must be used.

9 Wind conditions and site assessment

WASP can estimate the mean wind climate at all the sites in a wind farm – and anywhere in the terrain. To estimate, say, the 50-y extreme wind speed and the turbulence intensity at the turbine sites in a wind farm take a bit more. In this chapter, a simple step-by-step introduction to WASP Engineering and the Windfarm Assessment Tools is given, in order to derive the necessary result. Note that the focus of course 46200 is on the IEC 61400-1 standard and not on the details of the software packages.
One estimate of the 50-y extreme wind speed may be derived from the measurements at the meteorological mast: where the Climate Analyst can provide the observed extreme wind climate. This can be obtained by right-clicking Results and choose Create an Oewc, see Figure 22.

Figure 22. Sample observed extreme wind climate from Sprogø 1977-99; single events in a polar representation to the left and the extreme wind speed distribution with Gumbel fit to the right (data courtesy of Sund & Bælt). The 50-y extreme wind 70 m a.g.l. at this site is 33.3 ms⁻¹, cf. Figure 5.

The turbulence intensity can be calculated from the measurements of wind speed and standard deviation of wind speed, see Figure 23.

Figure 23. Observed turbulence intensities at a meteorological mast. The measurements have been binned in intervals of 1 ms⁻¹; mean values and standard deviations of the turbulence intensities in each bin are shown.

However, if the mast is not at hub height or is situated in terrain which is not similar to the terrain at the wind farm site, the observed extreme winds and turbulence intensities may not be representative of the turbine sites.
9.1 Extreme wind and turbulence intensity

It is possible to use WAsP Engineering to estimate the extreme winds and turbulence intensities at the turbine sites in the wind farm, without knowing every detail of the software or models. See the WAsP Engineering help file for more information.

First, you need to make a few input files to WAsP Engineering. In the Climate Analyst, you need to calculate and save the observed extreme wind climate:

1. Right-click Results and choose Create an Oewc
2. Right-click the Oewc and Export it to an *.oewc file

In WAsP, you need to export the different site locations and the wind atlas to files:

1. Right-click the met. station and Extract site location to a *.wsg file
2. Right-click the wind farm and Extract site locations to a *.wsg file
3. Right-click the wind atlas and Export to file... Choose the type *.lib

In WAsP Engineering, you need to set up a project for the wind farm:

1. From the File menu, choose Create new project...
2. Choose Use Vector Map and select the WAsP vector map for the project setup
3. Provide the latitude and select an area for the project
4. Define the flow domain structure according to the recommendations at www.wasp.dk/Support/FAQ/WengMaps.aspx
5. Right-click the Sites member and choose Insert site locations from file
6. Insert the met. station and the wind farm turbine sites in this way. The calculation height(s) of the sites should now be shown in the Heights pane.
7. From the Insert menu, choose Observed extreme wind climate from file...
   Select the *.oewc file that was exported from the Climate Analyst. And provide the met. mast coordinates.

Now, the basic WAsP Engineering project has been set up and you can do some calculations. For example, to estimate the extreme winds at the sites, do the following:

1. Right-click the parent object of the met. station and choose Calculate a generalised extreme wind climate. NB: This may be a lengthy calculation¹.
2. Left-click your wind farm, hub height and generalised extreme wind climate in the hierarchy in order to select objects for further calculation.
3. In the Tools menu, choose Scripts and then Applied EWC report: 50 y winds for all sites and heights.

Check the results in the MS Word file that opens; this will give you information about the 50-y extreme winds at the sites.

¹) You can speed up extreme wind calculations in two ways: 1) Press Edit | Project settings | Climate calculations and modify the interpolation scheme, or 2) press Edit | Re-define project domain and reduce the flow model domain. Consider your choices carefully as the need for detail depends on the terrain.
9.2 IEC site assessment

To make a full IEC site assessment, a combination of WAsP and WAsP Engineering results need to be post-processed in the Wind farm Assessment Tool (WAT):

1. Left-click a group of turbines, the hub height of these turbines and the regional extreme wind climate in the hierarchy in order to select these for calculation.
2. In the Tools menu, choose Prepare data for WAT
3. Select the *.lib file you exported from WAsP
4. Select the appropriate wind turbine generator file (*.wtg or *.pow)
5. Choose Display the results in Excel and press OK

Check the results in the MS Excel file that opens; this will contain information about the 50-y extreme wind speed, terrain inclination, wind rose, Weibull $A$- and $k$-parameters, speed-up factor, wind direction deflection, wind shear exponent, turbulence intensity ($u$, $v$, and $w$ components), standard deviation of wind speed and flow angle.

Windfarm Assessment Tool (WAT)

The WAT tool is needed to estimate the effective turbulence intensity:

1. Right-click on Terrain Maps | Elevation grid and save the map in Surfer format.
2. Save and close the Excel Workbook
3. Open WAT and select Edit | Add WAsP/WEng results to import data from the Excel Workbook and wind turbine generator file.
4. Specify the turbine class and turbulence category according to the turbine certificate.
5. Select Edit | Add Terrain data and load the Surfer file.
6. Select an appropriate Wöhler exponent for the weakest part of the turbine, typically $m = 10$ for glass fibre blades.
7. Select Wind farm overview | Flow conditions and check whether all turbine sites obey IEC 61400-1 site assessment rules. Select individual sites and use reports for selected site to investigate specific problems.

References


2) For a complex wind farm with more than one turbine type you can 1) organize the WAsP Engineering project in groups with similar turbines, 2) prepare WAT data for each group and hub height, and 3) import and merge group results in WAT.


Other resources


IEC 61400 Wind turbine generator systems.


European Wind Energy Association: Wind Energy – The facts

Wind Atlases of the World web site: www.windatlas.dk

Wind Atlas for South Africa download site: wasadata.csir.co.za/wasa1/WASADat

Course software

WAsP and WAsP Engineering web site: www.wasp.dk

WAsP Licence System Standard 3.0.0.0 (WaspLicencingSystemStandard.msi)

WAsP 10.2.0.10 (WAsP-10-2-ReleaseB-Build10.msi)

WAsP Map Editor 10.1.0.320 (MapEditor10-1-Build320.msi)

WAsP Climate Analyst 2.0.0.86 (Waca-2-0-ReleaseA-Build86.msi)

WAsP Weibull Explorer (Weibull2009-06-19.msi)

WAsP Engineering 3.0.0.188 (Weng-3-0-ReleaseD-Build188.msi)

Windfarm Assessment Tool 3.0.0.128 (WindfarmAssessmentTool-3-0-Build128.msi)

Acknowledgements

The WAsP software is developed and maintained by a large team of scientists, software designers, programmers, and technical support staff at DTU Wind Energy (formerly the Wind Energy Department at Risø DTU) and World in a Box Oy. Without this team effort there would be no software, no training courses and no course notes like these. The help and support of the WAsP team are gratefully acknowledged; Morten Nielsen specifically helped with the procedures and text in Section 9.

Appendices

The following appendices are annexed to this report:

A. WAsP best practice and checklist
B. A note on the use of SAGA GIS
C. Digitisation of the land cover / roughness map
WAsP best practice and checklist

This list of requirements, best practices and recommendations is not exhaustive, but is meant to provide a brief summary of some important considerations regarding WAsP modelling. More information is available in the WAsP help system and at www.wasp.dk.

Measurement programme

- Design measurement programme based on preliminary WAsP analysis
  - Use SRTM elevation and water body data + land cover from Google Earth
  - Follow WAsP similarity principle as much as possible when siting the mast(s)
  - Height of reference anemometer(s) similar to hub height (preferably > 2/3 \( h_{\text{hub}} \))
  - Optimum boom direction is oriented @ 90° (lattice) or @ 45° (tubular) to the prevailing wind direction.
- Deploy 2 or more masts for horizontal extrapolation and verification
- Deploy 2 or more masts if RIX and \( \Delta \text{RIX} \) analyses are required
- Deploy 2 or more levels on masts for wind profile analyses and verification
- Deploy 2 or more levels on masts for redundancy in instrumentation
- Measure temperature (@ hub height) and pressure for air density calculations
- Are anemometers calibrated according to international/traceable standards?

Wind data analysis

- Collect required information, e.g. by filling out a WAsP Data Description Form
- All fields in Climate Analyst protocol editor should correspond to data spec’s
- Plot and inspect time traces of all meteorological measurements
- Visual inspection of time-series – in particular reference wind speed and direction
- Visual inspection of polar scatter plot – any patterns or gaps?

Observed wind climate

- Use an integer number of whole years when calculating the OWC
- Check Weibull fit: is power density discrepancy < 1%?
- Check Weibull fit: is mean wind speed discrepancy < a few per cent?
- Check within context of long-term wind climate (MCP)

Elevation map(s)

- Size of map: should extend at least several (2-3) times the horizontal scale of significant terrain features from any site – meteorological mast, reference site, wind turbine site or resource grid point. This is typically 5-10 km.
- Coordinates and elevations must be in meters
- Set map projection and datum in the Map Editor
- Add spot heights within wind farm site; interpolate contours if necessary
- High-resolution contours around calculation sites: contour interval ≤ 10 m
- Low-resolution contours away from calculation sites: contour interval ≥ 10 m
- Non-rectangular maps are allowed (circular, elliptic, etc.)
- Check range of elevations in final map

Roughness/land cover map(s)

- Size: map should extend at least \( \max(150 \times h, 10 \text{ km}) \) from any site – meteorological mast, reference site, turbine site or resource grid point.
- Coordinates and roughness lengths must be in meters
- Set map projection and datum in the Map Editor
- Set roughness length of water surfaces to 0.0 m!
- Check range of roughness length values in final map
- Map date should correspond to modelling scenario (met. mast or wind farm) – use two maps in hierarchy if necessary.
- Check for dead ends and cross points – and edit map as needed
- Check consistency of roughness values – there must be no LFR-errors!

**Sheltering obstacles**
- Is site closer to obstacle than 50 obstacle heights and height lower than about 3 obstacle heights?
- If yes to both, treat as sheltering obstacle; if no, treat as roughness element

**WAsP modelling – site visit**
- Go on a site visit! Use e.g. the WAsP Site/Station Inspection Checklists
- Print and bring the WAsP forms for recording the necessary information
- Bring GPS and check projection and datum settings – change if required
- Determine coordinates of all masts, sites, landmarks and other characteristic points on site.
- Bring sighting compass and determine boom directions and check wind vane calibration.
- Take photos of station and surroundings (12 × 30°-sector panorama)
- Download GPS data and photographs to PC as soon as possible (daily)

**WAsP modelling – parameters**
- Wind atlas structure: roughness classes should span and represent the site conditions.
- Wind atlas structure: standard heights should span and represent the project conditions.
- Adjust off- & on-shore mean- and RMS-heat fluxes values to site conditions (*caution!*)
- Ambient climate: Set air density to site-specific value (WAsP 10 only)

**WAsP modelling – analysis and application**
- Get site-specific (density, noise, ...) wind turbine generator data from the wind turbine manufacturer.
- Within forest: effective height = nominal height minus displacement length
- Complex or steep terrain is when RIX > 0 for one or more sites (terrain slope angles > 17° or 30%).
- Make RIX and ∆RIX analyses if RIX > 0 for any calculation site

**WAsP modelling – offshore**
- Roughness length of sea (and other water) surfaces: set to 0.0 m in WAsP!
- Add combined elevation/roughness change line around wind farm site
- Change wake decay constant to offshore conditions

**WAsP modelling – sensitivity analyses and uncertainties**
- Sensitivity of results to background roughness value and other important parameters.
- Identify and try to estimate the main uncertainties
- Estimate technical losses and uncertainty for calculation of net AEP @ PCC
A note on the use of SAGA GIS

SAGA (System for Automated Geo-scientific Analyses) is a GIS system developed by University of Göttingen; the home page is www.saga-gis.org. SAGA GIS can be used to make WAsP height contour (vector) maps from different kinds of gridded (raster) data.

Processing an SRTM grid for WAsP use

SRTM elevation data can be downloaded from dds.cr.usgs.gov/srtm/version2_1/. Once you have downloaded and unzipped a 1°×1° tile, import the grid from the Modules menu:

Left-click in the white field next to Files and enter or select the grid file name (*.hgt):

Make the height contours from the Modules menu, selecting the range and contour interval:

Set the grid system and contour interval in the Contour lines from grid window:
The Data workspace (Tree view) should now look something like this:

where the Grids section contains the SRTM grid and the Shapes section the contour lines. Double-click the grid, e.g. “01. N39E121”, to display it – same goes for the Shape “01. N39E121”. The Maps workspace could look something like this:

Finally, export the height contours to a WAsP terrain map file from the Modules menu:

Each SRTM3 grid file covers a 1°×1° tile and contains 1201×1201 cells; an SRTM1 (US only) grid file also covers a 1°×1° tile but contains 3601×3601 cells. This is sometimes too much information too process or too large an area. The imported SRTM grid can be trimmed from the Modules menu:

Grid > Construction > Cutting [interactive]

First, show the grid in a Map window. Next, start the Cutting tool, select the grid system and grid and click Okay. Next, select the Action pointer (the black arrow) in the toolbar:

In the Map window, drag out (left click and drag) the approximate area for the sub-grid that you would like to extract. A Cut window now pops up:
The sub-grid configuration may be changed here. Press **Okay** to continue. Finally, you must stop the interactive cutting module again by deselecting it in the **Modules** menu. You will not be able to use other modules before this interactive one has been shut down!

The **Data** workspace should now look something like this:

![Data workspace](image)

The new (sub)grid can be contoured and exported as a WAsP map file as described above.

![New grid](image)

The coordinates of the exported WAsP map file are geographical latitude and longitude; these must be transformed to a metric coordinate system in the WAsP Map Editor:

1. **Open** the map in the Map Editor.
2. Click **Yes** to switch to geographic Lat-Lon coordinate system, and then **Ok** twice.
3. Next, select **Tools > Transform > Projection**.
4. Select **Global Projections > UTM projection** for the Projection Type.
5. Leave Datum as WGS 1984 (or change to other) global/local datum.

6. Press Ok to transform map coordinates.

The map editor window could now look something like this:

![Map Editor Window](image)

**Processing an SWBD shape file for WAsP use**

The *SRTM Water Body Data* (SWBD) set contains coastlines, lakes, and rivers in SHP format. These files can be downloaded from [dds.cr.usgs.gov/srtm/version2_1/SWBD/](https://dds.cr.usgs.gov/srtm/version2_1/SWBD/). SAGA GIS can read such files, but so can the WAsP Map Editor.

Once you have downloaded and unzipped a $1^\circ \times 1^\circ$ tile, import the SHP file from the Map Editors *File > Import > ESRI shape file maps*. Note that the SWBD data contain lines along the tile boundaries; these lines are artefacts of the data set and have to be removed. The coastlines in a vector map should just end at the border of the map.
Digitisation of the land cover (roughness) map

The land cover (roughness length) map can be digitised from a scanned paper map, aerial photograph or satellite imagery as described in the Map Editor Help file. However, there are a few other options; these are described below.

Importing Google Earth imagery into WAsP and the Map Editor

Google Earth (GE) images can be imported into WAsP 10 and the Map Editor:

1. Insert an elevation map into the WAsP hierarchy
2. Show the vector map in a new spatial view
3. Click the “Synchronise view with virtual globe” (GE) icon
4. Click the “Frame current view in virtual globe” icon (four purple markers)
5. Go to GE where four purple markers have now been inserted in the image
6. Select Edit and Copy Image in GE
7. Go back to WAsP
8. Right-click the vector map and select Insert spatial image from clipboard...

The GE image can now be seen in the spatial view of WAsP. To use it in the Map Editor:

1. Right-click the spatial image in the hierarchy and select Export to file...
2. Save the image to disk file. A scaling file is saved automatically as well
3. This image is saved with scaling information and can now be loaded as a background map in the Map Editor.

Digitising lines directly in Google Earth

You can also digitise roughness change lines directly in Google Earth:

1. Untick the Terrain feature in Google Earth so the terrain appears completely flat
2. Make a folder in the GE hierarchy to contain the roughness change lines
3. Right-click on this folder and select the Add part of the menu
4. Select Path (polyline) or Polygon (polygon, i.e. a closed line)
5. Start digitising the first land cover / roughness change line
6. Continue digitising land cover / roughness change lines
7. When done, right-click the folder and choose Save Place As...
8. Choose the GE *.kml format and save the roughness lines to a file

The *.kml file can be converted to a *.map file using the program KMLscannerDemo:

1. First, Read the *.kml file
2. Then, Save the WAsP *.map file
3. Load the map file in the Map Editor
4. Change coordinate system as needed
5. Show the map graphic and set the properties for each line
DTU Wind Energy is a department of the Technical University of Denmark with a unique integration of research, education, innovation and public/private sector consulting in the field of wind energy. Our activities develop new opportunities and technology for the global and Danish exploitation of wind energy. Research focuses on key technical-scientific fields, which are central for the development, innovation and use of wind energy and provides the basis for advanced education at the university.

We have more than 230 staff members of which approximately 60 are PhD students. Research is conducted within 9 research programmes organized into three main topics: Wind energy systems, Wind turbine technology and Basics for wind energy.